JDE E1 HCM SIG Conference Call:

Please join our monthly conference call to learn more about topics of interest, current issues and workarounds/resolutions, and participate in our Open Forum.

President – Sherri Harley @ OUC
Vice-President – Ariel Ross @ Colas
Communications Coordinator – Rachel Springob @ City of Ft. Collins
Bug/Enhancement Coordinator – Denise Stewart @ Chocktaw Nation
Vendor Liaison/Demo Coordinator – Kristin Thill-Mckenzie @ Port of Portland
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FYI: 
Oracle is now certified. There is a bug but the XML fails (9.1)Bug 22951693 but this may be specific to Jeffco. Not everyone will get this error, keep going forward and log a call if you have n issue
XML may be missing the business name/address – a new template doc was sent out. 
	
Software Vendor Information  - create an address book record to populate the manifest XML the doc id # 2127093.1

ACA Doc ID 2038044.2



BUGS with ESU Available Status [image: C:\Users\harls131\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.IE5\FZ0TRSBU\wink-smiley[1].jpg] 

Linda Dresbach @ San Jose Water:  Just wanted to provide this if it is of interest to others: 
	R078401 Local Income tax Report Issue: .  R078401 company and grand total lines are 	incorrect whenever there is any ‘Excess’ wages for any employee.  The footer was 
	taking the excess of the last employee reported in coming up with the taxable wage 
	total instead of the summary excess amount. It has been wrong for a while but we 	finally got some time to document and report the error.  This is on 9.0
04/18/2016 Bug 20995248 Status 74 ESU JL23698 [image: ]  -- Doc ID 2006518.1 / Do not know if this is a 9.1 issue

Ariel @ Colas  9.1 tools 9.1.4.4 ... status = development; Verified by duplication in Oracle environments.  
When entering a Future Data update for a change to PHRT, if the R06394 is run in Full update mode to update the PHRT and SAL, the SAL update in the F08042 contains an incorrect value in the HSTN field. The incorrect value has 2 digits added to it. The incorrect value only occurs in the F08042 table and only in 9.1.4.4 tools release. 
05/16/2016 Bug 21313169 Status 74  ESU JM19481

Brent @ City of Rochester: P053030 W4 form missing merge elements. The W4FORM.HTM template puts the first and last name in the "first name and middle initial" field, nothing in the "last name" field, and does not merge employee marital status into the check box fields. 05/16/2016Bug 21312885 Status 74 ESU JM19517




BUG TRACKING(ESU Not Available Yet) 
Status 10 – Description Phase
Status 11 – Code/Hardware Bug (Response/Resolution)
Status 16 – Bug Screening/Triage
Status 21 – Cost Required, To Development
Status 25 – Open, Awaiting Code/Hardware review
Status 26 -  Open/Failed Verification
Status 30 – More Information Requested. To Filer
Status 69 – PSE to QA: Packages Delivered
Status 80 - Development to QA/Fix Delivered Internal
Status 82 - Q/A to Enhancement Evaluation
Status 91 – Closed, Could Not Reproduce
Status 92 – Closed, Not a Bug


1. Nancy @ Logis – W2 rebuild problem 05/16/2016 Bug 20656220 status 21


2. Nancy @ Logis  SR 3-11685461771 : 11/10/15 Open Enrollment not calculating DBA using P08505 As of Age. Build Open Enrollment Files correctly calculate the Employee Cost using the employee age as of 01/01/16 as seen from P085520W.  During Open Enrollment, the Employee Cost As of Current FAGE is shown. Duplicated 05/16/2016 Bug 22200158 Status 30

3. Nancy @ Logis 3-11683375741 : 11/10/15 Employee (Dependent) error on Required Plans during Open Enrollment Employee 2 is a dependent of Employee 1 and has Medical coverage through Employee 1 Family election. Employee 2 correctly receives "You are listed as a dependent of another employee for this category” however the correct Opt Out/Waive functionality is not defaulting and an error is given that an election is required. Employee 2 cannot proceed with Open Enrollment.  05/16/2016 9.1 Bug 22240683 Status 26 / New Bug 23081278 Status 11

4. Pat Short Independent Consultant - The biggest ESS issue I have now is:                        3-11806940961 R085524 – Not using the correct ending dates when employee switches plans for a Life Qualifying Event.  On our Life Qualifying Events the Plan End dates are using the Event Date instead of using the Eligibility Rules and ending the plans the day before new plan start date.  So we have lapses in service and or overlapping enrollments.  Oracle is working on the fix now.  I had to explain to Oracle and the developers that we want it to work as the P08334 (which it should).  I opened the call December 2 and they finally started working on the bug at the beginning of February. 05/16/2016 Bug 22387883 Status 11 



5. Nancy @ Logis: I attempted to build my 1094C but found the following prerequisite issues:
1. We implemented in 1999 and back then DST.F08042 did not write when created from P060116Q.  DST is the first step of the R08118 Periods of Employment Build.  
1. Back then DT wrote 0 to JWHSTD.F08042 when employees were created from P060116Q.  HSTD 0 causes R08118 to write PEEFTQ.F08118 and PEOWTRS.F08118 to write in the 2nd step of the R08118 which then in turn causes the records to be skipped during the Employee Counts.

I found this by debugging the R08124A then the R08118.  I was also able to compare bad data to good data and database change the bad data to prove it out.

Looks like I’ll be doing massive SQL statements to find all of this data in the 25 datasets!  

6. Sherri OUC: Org Chart broken as of tools 9.1.5:  9.1 05/16 2016 BUG 23011708 9.2 BUG 23011816 Status 11 Double-click functionality broken in org charts



NEW ISSUES E-Mailed

FYI Alicia @ Oracle: Yes, I am sorry, there is confusion.  At Collaborate, based on information from the IRS instructions, I did say that you could submit the test without Oracle being certified.  The week after Collaborate, the IRS clarified that we would need to be certified before you could submit your test.   

Oracle is now certified

Travis Wendland @ Little Rapids Corporation:  Has a question about recruitment and affirmative action reporting.   Who is using recruitment functionality in E1 or a 3rd party that could talk with Travis? sking@brasfieldgorrie.com

Sherri @ OUC: 9.1 Testing my 1094C/1095C Transmission P08140 is wiping out my 1095C count.  SR 3-12646990341- I have to apply JM19477 doing that this week


Sherri @ OUC: SR 3-12428807422. When in the P07OTO1/W07OTO1C accessed from the payroll workbench, Go to DBA Review > DBA Detail > select a DBA code in the QBE line - click find. The browser just spins and spins, if press F5 it will stop and take me to the end of the data. This is only happening on 9.2 tools 9.2.0.3 Vertex 4.2. 
You need to have at least 7 timecards, and at least 30 DBA's with most of them being benefits or accruals this is also daily time entry.  This also happens if not using the QBE line but you’ve changed a few DBA’s and click SAVE. I have to press F5 to get the spinning to stop 05/16/2016 Bug 23063717 Status 11

Pam @ Saris-Regis: An Employee is enrolled in a benefit and has Employee Pay Instructions
(F06106) with a date and rate.  Prior to being included in payroll either the
employee goes through Open Enrollment (updated by R085524) or the rates are
recalculated from R083800/R083810.  This updates the original Employee Pay
Instructions (F06106) record with the new rate but does not update the
Effective Date (the original date exists in F06106 start date).

There is no reason to review the DBA Transaction Detail History (F0719).
It is preferable to stop the original Employee Pay Instructions (F06106) and
start a new Employee Pay Instructions (F06106) with the new effective date
and rate.

Due to requirements of benefit providers, the customer must process Open
Enrollment prior to the first payroll for new hires that are eligible the
month before open enrollment. Because of this, there are no payroll history
records for the DBA instructions with the prior year rate amount. 05/17/2016 Bug 23271512 Status 11




Suzanne @ Pinal County:  Is there a secret way to enroll employees through Enrollment w/Eligibility while payroll is locked? 
Katie@Brasfield&Gorrie: Advises against touching the employees while payroll is locked in any means, very sensitive and it’s best to stay away. 
Jody@ Railworks: Batch enrollment will not allow you to process if the records are locked either. 

Donna @ Blattner Energy: I have a question related to the ACA.  We applied for a TCC three weeks ago.  Our status on the IRS website shows completed.  A tracking number is displayed as well. Does anyone know how long it takes to get the TCC from the IRS?
	Sherri @OUC: My HR Director said it said 30 days. Maybe others heard differently
	Kari@City of Rochester: It took at least 30 days if not longer					


Sherri @ OUC: Testing E1 9.2 and Tools 9.2 the self-service flows are picking up a lot of extra space.  This does not happen on 9.1 and tools 9.1.4 
The space grows when you move the menu bar from top to bottom, side to bottom or side to top etc, it also only happens if you are using Director text 
SR 3-12581036211 05/10/2016  Bug 23183120 Status 11

No Text					With text			After moving menu bar
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Open Forum

Shelley@Oracle: Housekeeping Item – When you enter an ACA SR – please choose the ACA template, pull in the product Human Resources > Component is ACA

Darren@Paul Mueller: We entered a ticket here because of the multiple garnishment issue that Missouri now recognizes.  The bug is 05/17/2016 23237610 status 11.  This was already fixed in release 9.1, but we are using 9.0 so they are having to recreate the fix in that application release.

Cindy@ Lehigh Hanson: Canada - Quebec ... do we need the Canada/French version of JDE to provide 'legal' French language payrolls to Quebec employees? anything special to do to make this work other than set up taxes and dba's with french text?  

Arie@Colas: Language Package: Doc ID 650479.1, Doc ID 1297780.1, Doc ID 626156.1

Kari@City of Rochester: Does anyone allow Health Savings Account changes through employee self-service

Cindy@ Lehigh Hanson: 9.0 issue VETS4212 -- BUG 23262524 to fix hiring location name populate instead of the company #.

Sharon @ Brasfield & Gorrie: Update Employee Compensation R089990 –where is this coming from
Alicia@Oracle: This is an obsolete UBE that is no longer used

Ann @Seattle Housing : The newest ESU JM19477 is for part 2 ACA (this is for 9.1) 9.0 JL23683
Alicia @ Oracle: There will be another ACA ESU coming out next Tuesday – 

Evelyn @ POP: are those who are upgrading to 9.2 also struggling with converting customized grids? Port of Portland entered a ticket (don't have the number but can get it to you) and we have tried some things but no luck. 
Sherri@OUC – From my CNC guy: it's a little weird as Formats are now considered 
UDO's and need to be treated as objects, but some of the old rules of objects 
apply differently with UDO's. He said it would write something up. When I get it 
I will send out a communication (as of Friday at 7am I have not gotten anything) 
Darren:@Paul Mueller 9.2 E1 you have to upgrade to tools 9.2 DYoung@muel.com
[bookmark: _GoBack]Cindy@ Lehigh Hanson: - CA Prevailing Wages - is there more setup required than just BU Constants and Job Classification flags being set? are both of those settings required to get on the certified payroll.
There is one on the BU/Job Master (F0006)  	
Katie@ Brasfield: The option is on the Job Master = Y and there is a processing option when you run the report

Reyna Rodriguez @ Noven Pharmaceuticals in Miami: Does anyone know if each company needs to have a TCC # prior to sending the test to the IRS for ACA 1094-C (Phase II)?	
You have to have the TCC number to submit even the test. 
Linda Sloan-Compton@Pinal County: ACA XML format....   Is there a way to convert the XML to a delimited file to load into a 3rd party software to file
Alicia@Oracle: unknown there may be some sort of utility that does that – we don’t know – Nothing provided by JDE
Phil@Hoffman Construction: You could use the BIP which is driving the XLS stuff – you could replace with an RTF and create your own via a CSV

Christine@iHCM:Linda Sloan-Compton with Pinal County was asking about how to convert an XML file to a CSV file.  I know an answer was given on the phone, but here is one “low-tech” way to do it quickly with visuals to assist her:

Open a new empty Excel workbook
Click File>Open> and choose the existing XML file you want to convert to CSV
An “Open XML” dialog box will open.  Choose “As an XML table”.  Click OK.
[image: cid:image003.png@01D1B03E.FD92C3D0]
A message will come up telling you that Excel can create a schema for you.  Click Ok.
[image: cid:image004.png@01D1B03F.47EA9840]
Your workbook will now open with data populated in rows and columns.  An example (non-ACA) is shown here.
[image: cid:image005.png@01D1B03F.AD746650]
Click File>Save As> and choose a file location, file name AND csv format.  An Excel message will come up.  Click Yes.
[image: cid:image006.png@01D1B040.59B5D7A0]
You can now open the new file with Notepad (or other software) and see a standard comma delimited file.  (In my example, you’d remove the top line that came from the column headers in the XML schema that Excel created).

[image: cid:image007.png@01D1B041.2122D9F0]

Sharon@ Brasfield: Is anyone using the Create forms to create mail merge documents?
Vic@CSS: Yes he has and he created word doc

Ariel @ Colas: Is anyone a certified expert on Garnishments. Specifically WY?
Pam@Saris: Will check with her peeps and get back to Ariel

Darren @Paul Mueller: Missouri changed how garnishments are being done – Go to the attorneys not the courts. They can pay them once a month. Have a weekly payroll and they want it to be paid monthly.
Ariel@Colas: Payee rules on the A/P side to do them monthly, BW etc. make sure you set the voucher rules to be one per employee (Pam@Saris & Sherri@OUC do it this way to)









Leg/Reg Items Under Development Review @ Oracle:

1. Jeff @ Semco – SUI – Michigan.  Have to file # of employees paid in payroll containing the 12th of the month.  Also need subtotals by company on the export file.  Nancy had to customize for this and also EEs with multiple tax history types (one record required, was dropping the second).  Will determine what pay period includes the 12th and look at timecard history.  Will count EE as long as time is not excludable from unemployment insurance.  **Logic employed does not cover all use cases (i.e., multiple pay cycle codes).  6/14 –If you would like to provide input, please e-mail Alicia directly Alicia.gambrell@oracle.com.  Alicia met with Development, talked about how to code for this.  Feedback from development is under review by Alicia. 


If you would like items added to our next agenda, please contact sharley@ouc.com!

Contact Sherri or Ariel  if you would like to demo or have an idea for a demo

10

image3.png




image4.png
RACLE’ JD Edwards

Review Curent Elections
= ReviewlAdd Dependents.
Heslh or Vision Plan

Review/Add Beneficiries.
OUC Paid Life & ADAD Insurance
Retirement Savings Plans.

Other Beneficary Plans.

Preview Benefit Changes

Accept Beneit Changes

Final Beneft Confirm. Stmt.





image5.png
Self-Service Director
‘Sherri Harley
‘Congratulatins on your recent Marriage. For other qu

“The next series of screens allows you to view your cur
new spouse andlor dependent children. You have 30
dependents, otherwise, you wil have {o wat until Annt

Before coverage begins you MUST SEND A COPY Of
SOCIAL SECURITY CARD to HR/Benefis. Faiure to

Required documents may be e-mailed to benefiis@ou

‘Throughout this process, you can click on the yellow
‘must complete all screens then click FINISH on the Fi

Marriage.

= Review Current Elections.
Review/Add Dependents
Heslth or Vision Plan
Review/Add Beneficiries.
OUC Paid Life & ADAD Insurance
Retirement Savings Plans.
Other Beneficary Plans.
Preview Benefit Changes
Accept Beneit Changes
Final Benefit Confirm. Stmt.




image6.png
the ye
zm-m m,mmkmmimm

\=> Review Current Elections.

Review/Add Dependents
Fiealth or Vision Plan
Review/Add Beneficiaries

|




image7.png
Open XML

Please select how you would like to open this file:

© As an XML table

As a read-only workbook

Use the XML Source task pane

ok

e |

Help





image8.png
Microsoft Excel

]

2 5chema based on the XML source data.

[]In the future, do not show this message.

The specified XML source does not refer to a schema. Excel will reate

oK

Help





image9.png
B Machine B Host @ environment §d
XJDEO003BI Print Laser W-2's (4 part) PYJDEENT02 PYJDEENTO2 JPYS10
XJDEO003BI Print Laser W-2's (4 part) PYJDEENTO2 PYJDEENTO2 JPY910
XJDEOOO3BI Print Laser W-2's (4 part) PYJDEENTO2 PYJDEENTO2 JPY910





image10.png
Microsoft Excel =)

‘Some features in your workbook might be 105t f you save it as CSV (Comma delimited)

Do you want to keep using that format?

e ] [w ]





image11.png
|5 XMLto CSV example.csv E3|

T

Version,Title,Machine, Host,Environment, User, Role, Company, OneWorLdR:

XJDE00O3BI, Print
XJDE00O3BI, Print
XJDE00O3BI, Print
XJDE00O3BI, Print
XJDE00O3BI, Print
XJDE00O3BI, Print
XIDEODO3BI. Print

Laser
Laser
Laser
Laser
Laser
Laser
Laser

W-2's
We2's
We2's
We2's
We2's
We2's
We2ts

(s
(e
(e
(e
(e
(e
(4

part), PYIDEENTO2, PYJDEENTO2, JPYS10
part), PYIDEENTO2, PYJDEENTO2, JPYS10
part), PYIDEENTO2, PYJDEENTO2, JPYS10
part), PYIDEENTO2, PYJDEENTO2, JPYS10
part), PYIDEENTO2, PYJDEENTO2, JPYS10
part), PYIDEENTO2, PYJDEENTO2, JPYS10
part) , PYJDEENTO02, PYJDEENTO02, JPYS10,





image1.png
JDE E1 HCM SIG 09/15/2015 Conference Call:
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Please join our monthly conference callto leam more about topics of interest, current issues and
‘workaroundsresolutions, and participate in our Open Forum.

Citx GoToMeeting

Call details:

https:/iglobal.gotomeeting.com/join/250892581

United States +1(408)650-3131
Access Code: 250-892-581

0911512015 Agenda:

1. General Welcome

2. Demo: INFOCUS Recap including a Leg/Reg update and ACA key points and reference
information from Oracle
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